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RINGKASAN 

 

Analisis Pembentukan Hydroxycarbonate Apatit Pada Bubuk Glass Ionomer Tipe 

II dengan Penambahan Bioactive Glass Nano Silica Abu Ampas Tebu yang di 

Rendam Cairan Tubuh Buatan ;Wahyu Hidayat, 131610101002; 2017; 74 

halaman; Fakultas Kedokteran Gigi Universitas Jember. 

 

Dentin merupakan pembentuk utama struktur gigi dan meluas hampir 

keseluruh panjang gigi. Dentin merupakan jaringan keras tetapi juga elastis yang 

tersusun dari tubulus-tubulus kecil yang tersusun sejajar dalam matriks kolagen. 

Mineral dentin dapat menghilang akibat proses demineralisasi namun mineral dentin 

dapat dikembalikan dengan proses remineralisasi. Salah satu bahan remineralisasi 

adalah bioactive glass. Bioactive glass merupakan suatu bahan yang bereaksi dengan 

cairan tubuh  yang membentuk ikatan  kuat pada tulang dengan membentuk lapisan 

hydroxycarbonate apatite (HCA). Dibidang kedokteran gigi bioactive glass 

digunakan sebagai bahan tambahan glass ionomer. Bioactive glass nano silica dengan 

ukuran nano partikel sudah mulai dikembangankan karena bahan tersebut mampu 

membentuk HCA lebih cepat dibandingkan ukuran mikro partikel. Salah satu 

komposisi terbesar bioactive glass adalah silica. Sumbernya bisa dari bahan organic 

contohnya adalah abu ampas tebu. Tujuan penelitian mengetahui pembentukan 

struktur hydroxycarbonate apatite (HCA) dari bubuk glass ionomer yang 

ditambahkan bubuk bioactive glass nano silica abu ampas tebu yang direndam pada 

cairan tubuh buatan. 

Penelitian ini merupakan jenis penelitian eksperimental laboratoris dengan 

rancangan penelitian post-test with control group design. Terdapat 6 kelompok 

penelitian, yaitu : kelompok 1 (GIGB1) glass ionomer dengan penambahan bioactive 

glass nano silica ampas tebu 0,04 wt%  perendaman 5 menit,  kelompok 2  (GIGB2) 
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viii 

 

glass ionomer dengan penambahan bioactive glass nano silica ampas tebu 0,04 wt%  

perendaman 30 menit, kelompok 3 (GIGB3) glass ionomer dengan penambahan 

bioactive glass nano silica ampas tebu 0,04 wt%  perendaman 60 menit,   kelompok 4  

(GI1) glass ionomer dengan perendaman 5 manit, kelompok 5  (GI2) glass ionomer 

dengan perendaman 30 menit, kelompok 6 (GI3) glass ionomer dengan perendaman 

60 manit, selanjutnya analisis pembentukan HCA dilakukan menggunakan Scanning 

Electron Microscope dan  dilanjutkan  analisis area pembentukan HCA menggunakan 

aplikasi software ImageJ. 

Data hasil penelitian menunjukan perbedaan bermakna (p>0,05) pada  

pembentukan HCA antara kelompok glass ionomer yang ditambah bioactive glass 

nano sillica abu ampas tebu 0,04 wt% pada uji pembentukan HCA. Pembentukan 

HCA pada kelompok glass ionomer yang ditambah bioactive glass nano sillica lebih 

besar. Lamanya perendaman akan meningkatkan pembentukan HCA secara bermakna 

(p>0,05), semakin lama perendaman maka akan semakin meningkatkan pembentukan 

HCA. Disimpulkan penambahan 0,04 wt% bioactive glass nano silica dari abu ampas 

tebu pada bubuk glass ionomer dan waktu perendaman yang lama menyebabkan 

peningkatan pembentukan HCA. 
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BAB 1. PENDAHULUAN 

 

1.1 Latar Belakang 

Dentin merupakan pembentuk utama struktur gigi dan meluas hampir keseluruh 

panjang gigi. Dentin merupakan jaringan keras tetapi juga elastis yang tersusun dari 

tubulus-tubulus kecil tersusun sejajar dalam matriks kolagen(Simon dkk, 2011). 

Berdasarkan beratnya dentin terdiri dari 70% kristal hidroksiapatit (anorganik), 20% 

merupakan zat organik yang tersusun dari kolagen dan substansi dasar 

mukopolisakarida, 10% air dan berdasarkan volumenya terdiri dari 50% anorganik, 

30% organik dan 20% air. Dentin dibentuk oleh sel odontoblas, yang berasal dari sel 

ektomesenkim dan berbentuk kolumnar tinggi. Odontoblas tersusun memanjang 

mengelilingi pulpa gigi yang akan memulai pertahanan gigi dengan membentuk lapisan 

dentin yang baru sepanjang hidup (Berkovitz dkk, 2009).  

Pembentukan lapisan dentin baru bertujuan untuk mempertahankan lingkungan 

secara alami dari trauma, infeksi maupun gangguan lain. Mineral dentin dapat 

menghilang sebagian atau seluruhnya karena larut dalam asam yang biasanya 

disebabkan adanya karies, makanan yang mengandung gula, coklat dan minuman yang 

mengandung soda. Mineral dentin dapat dikembalikan jika pH saliva netral dan 

terdapat ion Ca2- dan PO4
3- yang cukup dilingkungan, sehinggaCa2- dan PO4

3- kembali 

ke dalam struktur hidroksiapatit. Proses tersebut dinamakan proses remineralisasi. 

Salah satu bahan yang bisa digunakan untuk bahan remineralisasi adalah bioactive 

glass  (Yunita dkk, 2011).  

Menurut penelitian yang dilakuakan oleh Chen, dkk. 2008 membuktikan bahwa 

Bioactive glass merupakan suatu bahan yang dapat bereaksi dengan cairan tubuh  untuk 

membentuk ikatan yang kuat dengan tulang. Ikatan tersebut akan dilanjutkan dengan 

pembentukan lapisan hydroxycarbonate apatite(HCA), dan interaksi biologis 

odontoblast untuk membentuk kolagen yang kemudian termineralisasi di atas lapisan 

HCA. Mekanisme bioactive glass meregenerasi dentin dengan membentuk lapisan 
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hydroxycarbonate apatite(HCA),setelah bereaksi dengan cairan tubuh buatan. 

Bioactive glass memiliki komposisi silikon dioksida (SiO2) (46.1 mol%), kalsium 

oksida (CaO) (26.9 mol%), natrium oksida (Na2O) (22.4 mol%), dan difosfor 

pentaoksida (P2O5)(2.6 mol%) yang mampu membentuk HCAdalam waktu kurang dari 

2 jam dan mengikat jaringan. (Farooq dkk, 2012).Hydroxycarbonate apatite(HCA) 

dengan rumus kimia Ca10 (PO4CO3)6 (OH)2 merupakan ion carbonate yang bergabung 

dalam Hydroxyapatit(HA) yang disintesis berasal dari karbon dioksida (CO2) 

berkontak dengan cairan tubuh buatan, yang menjadi pelarut dan menghasilkan anion 

carbonate (CO3
2-). Prinsipnya ion carbonate masuk ke dalam kisi kristal HA akan 

menggantikan ion hidroksil (OH-) dan (PO4
3-). Secara umum CO3

2- dominan menganti 

PO2
3- (Soejoko dkk, 2012). Ion carbonate (CO3

2-) yang sangat dominan menandakan 

kuantitas dari carbonate yang cukup  besar sehingga bidang kristalnya lebih dominan 

dari pada bidang kristal HA (Suryadi, 2011). 

Pembentukan hydroxycarbonate apatite (HCA) juga dipengaruhi oleh ukuran 

dari bioactive glass. Bioactive glass dengan ukuran nano  lebih cepat dalam proses 

pembentukan Hydroxyapatit (HA) dibandingkan dengan bioactive glass dengan ukuran 

partikel mikro  (Polini, 2013). Bioactive glass yang berukuran partikel nano akan 

berkontak dengan cairan tubuh, karena semakin banyak ion yang larut menyebabkan 

semakin banyak terjadinya pembentukan hydroxycarbonate apatite (HCA), yang 

kemudian akan termineralisasi menjadi HA. Selain lebih cepat dalam pembentukan 

hydroxycarbonate apatite (HCA), bioactive glass mempunyai kemampuan untuk 

meremineralisasi dentin (Carpalho, 2013). Oleh karena itu, penggunaan bioactive glass 

pada saat ini tidak hanya terbatas untuk regenerasi tulang saja, namun sudah mulai 

dikembangkan penggunaan bioactive glass dalam bidang kedokteran gigi. Sebagai 

bahan pelapis implan gigi untuk merangsang pembentukan osseointegrasi terhadap 

bahan implan (Jones, 2013), sebagai bahan remineralisasi untuk mengurangi 

hipersensitifitas gigi (Krishnan, 2013)  sebagai bahan untuk perbaikan tulang rahang 

akibat periodontitis (Abassi, 2015), dan sebagai bahan tambahan pada bubuk glass 
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ionomer untuk merestorasi gigi sekaligus meremineralisasi jaringan dentin yang rusak 

(Xie, 2008). Penelitian Mubrouk pada tahun 2012 membuktikan bahwa bubuk glass 

ionomer yang ditambahkan bioactive glass sebesar 0,04 wt% sudah mampu 

membentuk jaringan hidroksiapatit pada dentin gigi yang rusak. Glass ionomer yang 

ditambahkan bahan bioactive glass memiliki sifat fisik yang baik setelah diaplikasikan 

dalam rongga mulut. 

Salah satu komposisi dari bioactive glass adalah sillica, dimana salah satu 

sumber sillica adalah Abu ampas tebu. Tebu (Saccharum officinarum L.) merupakan 

salah satu hasil pertanian yang terbesar di Indonesia. Saat ini produksi utama dari tebu 

adalah gula, namun buangan atau limbah tebu tidak begitu diperhatikan. Pemanfaatan 

limbah ampas tebu masih belum optimal. Limbah tebu atau biasa disebut juga Baggase 

merupakan sisa pengolahan tebu yang sebagian besar digunakan sebagai bahan bakar 

ketel (boiler) yang menghasilkan limbah hasil pembakaran berupa abu baggase 

(Suhendarwati dkk, 2014). Baggase sementara ini sudah dimanfaatkan untuk beberapa 

bidang, seperti pemanfaatan sebagai bahan pengisi pembuatan paving, bahan pengisi 

kuat batu bata, dan memanfaatkan limbah ampas tebu sebagai tanah penimbun 

(landfilling) (Firmansyah, 2012). Ampas tebu (Baggase) mempunyai kandungan sillica 

yang cukup besar sehingga abu bagasse berpotensi sebagai bahan baku pembuatan 

sillica gel. Kandungan sillica yang terdapat pada abu baggase, yaitu lebih dari 50% 

sehingga berpotensi untuk digunakan sebagai bahan baku pembuatan bioactive glass 

nano sillica (Yusuf, 2014). 

Dari pemaparan di atas, diduga bahwa abu ampas tebu bisa dimanfaatkan 

sebagai bahan alternatif bioactive glass. Bioactive glass nano silica abu ampas tebu 

dapat dimanfaatkan sebagai bahan regenerasi dentin, namun saat ini belum diketahui 

pembentukan struktur hydroxycarbonate apatite. Salah satu cara untuk menganalisis 

pembentukan struktur hydroxycarbonate apatite dari bioactive glass nano silica ampas 

tebu menggunakan alat scanning electron microscope (SEM).  
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1.2 Rumusan Masalah 

Berdasarkan penjelasan pada latar belakang tersebut didapatkan rumusan 

masalah sebagai berikut : 

Apakah  terdapat pembentukan hydroxycarbonate apatite (HCA) dari glass 

ionomer tipe II dengan penambahan bioactive glass nano silica dari abu ampas tebu yang 

direndam pada cairan tubuh buatan? 

1.3 Tujuan Penelitian 

Tujuan dari penelitian yang dilakukan adalah : 

Mengetahui pembentukan hydroxycarbonate apatite (HCA) dari glass ionomer 

tipe II dengan penambahan bioactive glass nano silica dari abu ampas tebu yang 

direndam pada cairan tubuh buatan. 

1.4 Manfaat Penelitian 

Manfaat dari penelitian yang dilakukan adalah : 

a. Mengetahui pembentukan struktur hydroxycarbonate apatite dari bioactive glass 

nano silica abu ampas tebu ditambahkan pada bubuk glass ionomer tipe II. 

b. Bioactive glass nano silica dapat dipertimbangkan sebagai alternatif bahan di 

Kedokteran Gigi. 

c. Alternatif pengolahan abu ampas tebu supaya bernilai tinggi. 

d. Sebagai acuan untuk penelitian selanjutnya. 
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BAB 2. TINJAUAN PUSTAKA 

 

 

2.1 Dentin  

2.1.1 Pengertian dentin 

Dentin merupakan pembentuk utama struktur gigi dan meluas hampir keseluruh 

panjang gigi. Dentin merupakan jaringan keras tetapi juga elastis yang tersusun dari 

tubulus-tubulus kecil tersusun sejajar dalam matriks kolagen(Simon.dkk, 2011). 

2.1.2 Kandungan dentin 

Berdasarkan beratnya dentin terdiri dari 70% kristal hidroksiapatit (anorganik), 

20% merupakan zat organik yang tersusun dari kolagen dan substansi dasar 

mukopolisakarida, 10% air dan berdasarkan volumenya terdiri dari 50% anorganik, 

28% organik dan 20% air. Dentin dibentuk oleh odontoblas, Odontoblas merupakan 

sel yang responsibel terhadap pembentukan dentin. Odontoblas berasal dari sel 

ektomesenkim, berbentuk kolumnar tinggi. odontoblas tersusun memanjang 

mengelilingi pulpa gigi yang akan memulai pertahanan gigi dengan membentuk lapisan 

dentin yang baru sepanjang hidup(Berkovitz.dkk, 2009). 

2.1.3 Demineralisasi dentin 

Demineralisasi adalah hilangnya sebagian atau seluruh mineral dentin karena larut 

dalam asam. Semakin rendah pH maka akan meningkatkan ion hidrogen yang akan 

merusak hidoksiapatit enamel. Demineralisasi dapat disebabkan oleh karies dan non-

karies. Demineralisasi non karies terdiri dari atrisi, abrasi dan erosi. Erosi gigi dan karies 

gigi mempunyai kesamaan dari jenis kerusakannya, yaitu merupakan demineralisasi 

jaringan keras gigi yang disebabkan asam. Namun asal asam penyebab erosi berbeda 

dengan karies. Pada erosi yang menjadi penyebab asam adalah asam dari makanan-

minuman, uap asam yang berasal dari industri serta asam lambung yang secara langsung 

berkontak dengan gigi tanpa aktivitas bakteri. Sedangkan karies berasal dari asam yang 

merupakan hasil fermentasi karbohidrat sisa-sisa makanan oleh bakteri.Proses 

demineralisasi yang terjadi pada kristal apatit dapat dideskripsikan sebagai penggantian 
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ion PO43- menjadi ion HPO42- dengan tambahan H+ dan pada waktu yang sama, H+ 

mengalami penetralan (buffering). Akibat konversi tersebut, ion HPO42- tidak dapat 

berkontribusi kepada keseimbangan kristal hidroksiapatit normal karena mengandung 

PO43- lebih banyak dibandingkan HPO42 sehingga kristal hidroksiapatit larut. Hal ini yang 

disebut dengan demineralisasi. Reaksi demineralisasi dapat diuraikan sebagai berikut: 8H+ 

+ (Ca10 (PO4)6(OH)2) 6(HPO4) + 10Ca2+ + 2H2O  (Yunita.dkk 2011). 

2.1.4 Remineralisasi dentin 

 Proses remineralisasi akan berlangsung jika pH dinetralkan dan terdapat ion Ca2+ 

dan PO43- yang cukup pada lingkungan rongga mulut. Penguraian produk apatit dapat 

mencapai kondisi netral jika terjadi buffering. Ion Ca2+ dan PO43- pada saliva dapat 

menghambat proses penguraian melalui common ion effect. Hal ini menyebabkan 

rebuilding atau pembangunan kembali partikel apatit yang telah larut. Keberadaan ion Ca2+ 

dan PO43- akan mengisi kembali ruangan dari kristal yang telah terdemineralisasi. Proses 

tersebut dinamakan remineralisasi. Interaksi ini dapat ditingkatkan dengan keberadaan 

fluor pada lingkungan tempat bereaksinya ion-ion tersebut. Dasar kimiawi dari proses 

demineralisasi atau remineralisasi ini sama pada enamel, dentin, dan sementum akar 

(Yunita.dkk 2011). 

2.2Biactive glass  

2.2.1 Pengertian Biactive glass  

Biactive glass merupakan bahan yang mempengaruhi efek dan menyebabkan 

respon dari jaringan hidup, organisme dan sel, pada pembentukan hidroksiapatit yang 

dapat bereaksi dengan cairan tubuh dan menghasilkan pembentukan lapisan 

hidroksikarbonat apatite (HCA). Biactive glass dilaporkan mampu meregenerasi 

tulang, termasuk juga meregenerasi  dentin. Bahan biactive glass meregenerasi dentin 

dengan membentuk lapisan hidroksikarbonat apatit setelah bereaksi dengan cairan 

tubuh (Jones, 2013). 
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Bahan biactive glass (bioglass) ini pertama kali dikembangkan pada akhir tahun 

1960an oleh Larry Hench dan kolega di Universitas Florida selanjutnya dikembangkan 

oleh tim penelitiannya di Imperial College of London dan para peneliti lain diseluruh 

dunia. Biactive glassadalah suatu material oxide logam sintentis yang unik bereaksi 

dalam cairan tubuh untuk mempertinggi dan memperbesar kemampuan penyembuhan 

diri pada defek tulang. Biactive glasstidak hanya membantu regenerasi normal akan 

tetapi juga pada akhirnya akan diserap dalam proses tersebut. 

2.2.2 Kandungan  Biactive glass 

Biactive glass memiliki komposisi silikon dioksida (SiO2) (46.1 mol%), kalsium 

oksida (CaO) (26.9 mol%), natrium oksida (Na2O) (22.4 mol%), dan difosfor 

pentaoksida (P2O5)(2.6 mol%) yang mampu membentuk HCAdalam waktu kurang dari 

2 jam dan mengikat jaringan (Farooq dkk, 2012).  

2.2.3Bioactive Sol-Gel Glass 

Biactive glass dapat dibuat dengan menggunakan dua metode pengolahan: 

metode traditional melt-quenching dan metode sol-gel. Bioglass 45S5 dan biactive 

glass komersial lainnya yang dibuat dengan metode traditional melt-quenching dimana 

oksida dilelehkan bersama-sama pada suhu tinggi (di atas 1.300oC) dalam cawan 

platinum dan padam dalam cetakan grafit (untuk batang atau monolit) atau di dalam air 

(frit). Metode sol-gel dasarnya membentuk dan merakit nanopartikel sillica pada suhu 

kamar. Ini adalah metode sintesis berbasis kimia di mana larutan yang mengandung 

prekursor komposisi mengalami polymertype reaksi pada suhu kamar untuk 

membentuk gel. Gel adalah jaringan basah anorganik sillica kovalen, yang kemudian 

dapat dikeringkan dan dipanaskan, misalnya pada suhu 600oC untuk menjadi glass. 

Komposisi bioaktif khas dalam sistem terner, misalnya 58S (60% SiO2 mol., 36 mol.% 

CaO, 4 mol% P2O5) dan 77S (80 mol.% SiO2, 16 mol.% CaO, 4% P2O5 mol.), atau 

sistem biner, misalnya 70S30C (70 mol.% SiO2, 30 mol.% CaO) (Saravanapavan, 

2003).  

Perbedaan fisik dalam metode traditional melt-quenching dan sol-gel yang 

diturunkan adalah bahwa kacamata sol-gel cenderung memiliki nanoporosity melekat 
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sedangkan sedangkan metode traditional melt-quenching gelas yang padat. 

Nanoporosity dapat menghasilkan respon seluler ditingkatkan karena nanotopography 

dan luas permukaan spesifik dua kali lipat lebih tinggi daripada komposisi serupa 

dengan metode traditional melt-quenching. Komposisi sol-gel biasanya memiliki 

komponen lebih sedikit dari bioaktif glass dengan metode traditional melt-quenching. 

Hal ini karena peran utama Na2O pada metode traditional melt-quenching kaca bioaktif 

adalah untuk menurunkan titik leleh dan meningkatkan processability. Hal ini juga 

meningkatkan kelarutan kaca yang penting untuk bioaktivitas. Luas permukaan dengan 

metode sol-gel kaca dihasilkan tingkat pelarutan tinggi dan karena tidak ada titik leleh 

yang terlibat, natrium tidak diperlukan dalam komposisi. Meskipun demikian, metode 

sol-gel telah diproduksi dekat dengan komposisi 45S5, misalnya 49,15 mol.% SiO2, 

25,80 mol.% CaO, 23,33 mol.% Na2O, 1,72 mol.% P2O5, meskipun gel tidak harus 

dipanaskan di atas 600o C jika gelas yang tetap amorf (Jones, 2013). 

 

2.3Hydroxycarbonate apatite (HCA) 

2.3.1 Pengertian Hydroxycarbonate apatite (HCA) 

Hydroxycarbonate apatite (HCA) merupakan lapisan yang terbentuk dari 

biactive glass yang bereaksi dengan cairan tubuh. HCA terbentuk dengan masuknya 

OH- dan CO32-  ke cairan tubuh(Jones, 2013). HCA ini dapat dimanfaatkan sebagai 

material substitusi tulang dan remineralisasi enamel (email gigi). Selain itu HCA juga 

dapat meningkatkan respon sel dan sifat osteokonduktifitas serta menurunkan ion-ion 

logam ketika digunakan sebagai bahan pelapis implan tulang (Landi E. dkk, 2003; 

Roveri N. dkk, 2008). 

2.3.2 Pembentukan Hydroxycarbonate apatite (HCA) 

Mekanisme pembentukan lapisan HCA diawali dengan adanya bahan biactive 

glass yang terpapar cairan tubuh, ion-ion alkalinya akan terlepas dan diganti kation H+ 

atau H30
+ dari cairan tubuh setelah itu akan terjadi peningkatan pH lokal yang 
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menyebabkan kerusakan ikatan Si-O-Si dan pelepasan silikon, sehingga terbentuk 

golongan silanol. Jika pH lokal kurang dari 9.5, kelompok silanol berpolimerisasi dan 

berkondensasi pada permukaan biactive glass , membentuk lapisan gel sillica. Struktur 

sillica akan terus mengalami pertukaran ion. Ion kalsium dan fosfat serta ion-ion yang 

ada pada cairan tubuh akan  bermigrasi melalui lapisan gel sillica, lalu membentuk 

lapisan amorphous calcium phosphate di atas lapisan gel sillica. Setelah pertumbuhan 

gel sillica dan lapisan kalsium fosfat, akan terjadi penggabungan OH- dan CO3-2 yang 

menyebabkan kristalisasi HCA yang akan aktif secara biologis dan penting dalam 

ikatan untuk jaringan hidup. Jika HCA terpapar dengan cairan tubuh, akan 

memungkinkan interaksi dengan gugus biologis seperti serat kolagen, fibronektin, 

protein plasma, darah, fibroblas dan osteoblas, yang akan berikatan kuat antara 

biomaterial dengan lingkungan fisiologis (Jones, 2013 dan shah, 2014). 

2.3.2 Struktur Hydroxycarbonate apatite (HCA) 

 Hydroxycarbonate apatite (HCA) merupakan ion carbonat yang bergabung 

didalam apatit. Prinsipnya ion karbonat mengganti struktur apatit di daerah OH (tipe 

A) dan di daerah PO4
-. Secara umum CO3

2- dominan menganti PO2
3. (Soejoko dkk, 

2012). Berdasarkan sampel sintetik, penggantian carbonat menyebabkan perubahan 

sifat fisik apatit (Soejoko dkk, 2012). 

 

 

Gambar 2.1  Struktur HCA setelah perendaman dengan Stimulated Body Fluids 

(Montazerian, 2016). 
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2.4 Sillica  

Sillica adalah senyawa kimia dengan rumus molekul SiO2 (silicon dioxsida) yang 

dapat diperoleh dari sillica mineral, nabati dan sintesis kristal. Sillica terbentuk melalui 

ikatan kovalen yang kuat serta memiliki struktur dengan empat atom oksigen terikat 

pada posisi sudut tetrahedral di sekitar atom pusat yaitu atom silikon. Gambar 1  

memperlihatkan struktur sillica tetrahedral.  

 

Gambar 2.1  Struktur sillica tetrahedral (Sumber : Im, 2011) 

Sillica termasuk dalam golongan bahan oksida yang mempunyai potensi untuk 

pemanfaatan aplikasi teknologi tinggi. Berdasarkan hasil pengujian terbaru, didapatkan 

bahwa unsur sillica yang paling dominan di dalam bahan biactive glass juga terdapat 

di dalam ampas tebu (Kharimah dkk, 2014). Pada ampas tebu (baggase) terdapat 

kandungan sillica (CiSO2) yang cukup tinggi, yaitu lebih dari 50% sehingga berpotensi 

untuk digunakan sebagai bahan baku pembuatan biactive glass nano sillica  (Yusuf, 

2014). Pada penelitian sebelumnya terbukti bahwa kandungan sillica dalam abu 

bagasse besar sehingga abu bagasse berpotensi sebagai bahan baku pembuatan sillica 

gel. Sillica oksida (SiO2) yang terdapat pada abu ampas tebu berbentuk amorf, yaitu 

suatu padatan dengan susunan partikel yang tidak teratur atau tidak berbentuk.  Sillica 

amorf adalah material yang dihasilkan dari reaksi alkali-sillica. Reaksi alkali-sillica 
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dimulai dengan pecahnya ikatan Si-O-Si dan hasilnya membentuk fase amorf dan 

nanokristal. Sillica amorf terbentuk ketika silikon teroksidasi secara termal. Sillica 

amorf terdapat dalam beberapa bentuk yang tersusun dari partikel-partikel kecil yang 

kemungkinan ikut tergabung. Biasanya sillica amorf mempunyai kerapatan 2,21 g/cm 

(Harsono, 2006).  

 

2.5 Nano Sillica  

Berkembangnya teknologi sekarang ini menyebabkan aplikasi penggunaan 

sillica pada industri semakin meningkat terutama penggunaan sillica yang memiliki 

ukuran partikel kecil sampai dengan skala nano. Ukuran partikel bahan baku yang 

diperkecil membuat produk memiliki sifat yang berbeda dibanding ketika ukurannya 

besar. Ukuran sillica sampai skala nano memerlukan perlakuan khusus salah satunya 

dengan metode sol-gel proses ( Jayanti, 2014). 

Proses sol-gel telah banyak dikembangkan terutama untuk pembuatan hibrida, 

kombinasi oksida anorganik (terutama sillica) dengan alkoksisilan. Proses ini 

didasarkan pada prekursor molekular yang dapat mengalami hidrolisis, kebanyakan 

merupakan alkoksida logam atau semi logam. Proses sol-gel merupakan suatu suspensi 

koloid dari partikel sillica yang digelkan ke bentuk padatan. Menurut Rahaman (1995) 

suspensi dari partikel koloid pada suatu cairan atau molekul polimer disebut sol. Proses 

sol-gel dapat digambarkan sebagai pembentukan suatu jaringan oksida melalui reaksi 

polikondensasi yang progresif dari molekul prekursor dalam medium cair atau 

merupakan proses untuk membentuk material melalui suatu sol, gelation dari sol dan 

akhirnya membentuk gel (Schubert and Husing, 2000). 

 

2.6 Glass Ionomer Cement (GIC) 

 

2.6.1 Definisi Glass Ionomer Cement (GIC) 

 Glass ionomer cement atau Semen Ionomer Kaca (GIC atau SIK) 

merupakanbahan restorasi yang banyak digunakan oleh dokter gigi dan terus 
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dikembangkan. GIC memiliki kemampuan berikatan secara fisikokimiawi baik pada 

email maupun dentin. Glass ionomer cement (GIC) merupakan salah satu bahan 

restorasi yang sering digunakan karena material ini dianggap paling biokompatibel. 

(Noort, 2007) 

GIC diperkenalkan pada tahun 1972 oleh Wilson dan Kent. Sifat fisik GIC 

yang adhesif ke permukaan enamel dan dentin, melepaskan fluor ke jaringan gigi, 

biokompatibel pada jaringan pulpa, dan koefisien termal ekspansi sama dengan gigi 

membuat GIC banyak digunakan. (Hawlett, 2003) 

2.6.2 Komposisi Glass Ionomer 

Glass Ionomer terdiri dari bubuk calcium/strontium flouroaluminosillicat glass dan 

liquid (larutan poli asam). Komponen yang terkandung dalam bubuk kaca adalah: SiO2 

(35,2-41,9%), Al2O3 (20,1-28,6%), CaF2(15,7-20,1%), Na3AlF6 (4,1-9,3%)., 

AlF3(1,6-8,9%), dan AlPo4 (3,8-12,1%). Likuid terdiri dari: air dan asam poliakrilik 

dengan konsentrasi 40-50% dan kadangkala ditambah asam maleik atau asam 

fumarik.Fungsi komponen Glass ionomer adalah : 

1) Alumina (Al2O3)  :Meningkatkan opasitas  

2) Silika (SiO2) :Meningkatkan translusensi  

3) Fluorida :Antikariogenik, meningkatkan translusensi,   

working time dan kekuatan 

4) Kalsium fluorida :Meningkatkan opasitas  

5) Aluminium fosfat :Menurunkan melting time (waktu mencair)      dan 

meningkatkan translusensi  

6) Kriolit (Na3AlF6) :Meningkatkan translusensi  

7) Ion Na, K, Ca, Sr  

Sementara kandungan liquid (larutan poliasam) : 

Asam poliakrilat, asam polimaleat, kopolimer asam akrilat-asam itakonat, 

kopolimer asam-asam maleat, kopolimer asam akrilat-asam2-buten dikarboksilat dan 

vinyl phosponic acid. Poli asam memeberikan kempampuan Glass ionomer cement 

untuk melekat pada struktur gigi tanpa perlakuan khusus.  (Annusavice, 2012). 
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2.6.3 Klasifikasi Glass Ionomer Cement (GIC) 

 Istilah semen ionomer kaca harus diterapkan hanya untuk bahan yang 

melibatkan signifikasi asam - reaksi dasar sebagai bagian dari pengaturan reaksi dan 

menunjukkan fluorida yang rilis. Dalam beberapa definisi, ada sejumlah aplikasi untuk 

semen dan mereka dapat di klasifikasikan sebagai berikut:  

Tipe I       : perekat mahkota, jembatan dan breket ortodontik (luting cement)  

Tipe II   a : semen restorative estetik  

  b : semen restorative reinforced  

Tipe III     : semen pelapis, basis (lining dan base cement)  (Annusavice, 2012) 

Struktur kimia dasar ketiga kelompok pada dasarnya sama, tetapi memiliki 

powder/liquid ratio dan ukuran partikel powder yang berbeda untuk menunjang fungsi 

yang diharapkan. Semen ionomer kaca memiliki karakteristik tertentu yang menarik 

sehingga ikatan adhesi mereka ke enamel dan dentin, rilis ion fluorida selama periode 

waktu yang lama adalah biokompatibel dan memiliki koefisien ekspansi termal yang 

sama sebagai struktur gigi.Setiap semen harus dinilai untuk biokompatibilitas, 

keamanan, dan efektivitas. Idealnya semen tidak menyebabkan kerusakan pada gigi, 

memiliki ke cocok sifat fisik tujuan penggunaannya, dan menyediakan sifat pasif atau 

aktif (bioaktif), sehingga tubuh tidak harus mengakui benda asing, sehingga 

penyembuhan luka pada jaringan dapat dimulai sesegera mungkin. Semen gigi adalah 

bahan yang mengatur intraoral dan biasanya digunakan untuk penambal gigi dan 

prosthesis. Mereka diklasifikasikan menurut reaksi komponen kimia utama mereka. 

(Annusavice, 2012) 

 1). Semen ionomer kaca konvensional  

Semen ionomer kaca konvensional pertama kali diperkenalkan pada tahun 1972 

oleh Wilson dan Kent. Bahan ini berasal dari asam polialkenoat cair seperti asam 

poliakrilat dan komponen kaca yang biasanya adalah fluoroalumino sillicat. Reaksi 

asam basa terjadi saat powder dan liquid dicampur menjadi satu.  

2). Resin-modified glass ionomer cement  
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Resin-Modified Glass ionomer cement mengkombinasikan reaksi asam-basa 

ionomer kaca tradisional dengan reaksi polimerisasi amine-peroksida (self-cured). 

Sistem light-cured ini telah dikembangkan dengan menambahkan kelompok 

methacrylate fungsional yang dapat dipolimerisasi dengan photo-initiator pada 

formulasi ini. Dikembangkan pada tahun 1992 resin-modified glass ionomer cement 

dalam bentuk paling sederhana adalah semen ionomer kaca yang mengandung sedikit 

komponen resin larut dalam air, yang dapat dipolimerisasi. Bahan yang lebih rumit 

telah dikembangkan dengan memodifikasi asam polialkenoat dengan rantai samping 

yang dapat dipolimerisasi menggunakan mekanisme light-cured dengan adanya photo 

initiators, namun pengerasan tetap terjadi melalui reaksi asam-basa. 

3). Metal-reinforced glass ionomer cements  

Metal-reinforced glass ionomer cements pertama kali diperkenalkan pada tahun 

1977. Penambahan bubuk campuran perak-amalgam pada bahan konvensional  

meningkatkan kekuatan fisik semen dan memberikan radiopasitas. Selanjutnya, 

partikel perak dilelehkan menjadi serpihan-serpihan seperti kaca, dan sejumlah produk 

kemudian muncul dimana kandungan campuran amalgam telah ditetapkan untuk 

memperbaiki keluhan sampai tingkat yang dikatakan menghasilkan sifat mekanis 

optimum untuk metal-reinforced glass ionomer cement. (Annusavice, 2012) 

2.6.4 Sifat-sifat Glass Ionomer Cement 

 Semen ionomer kaca menunjukkan berbagai sifat dan jelas material yang sangat 

beragam, yaitu:  

a. Adhesi  

Adhesi semen ionomer kaca membantu dalam menyediakan pendekatan 

konservatif untuk restorasi dan perlekatan yang sempurna.  

b. Biokompatibilitas  

Pengaruh yang merugikan dari semen ionomer kaca pada jaringan hidup adalah 

minimal. Tidak ada efek sakit disebabkan oleh asam poliakrilat karena merupakan 

asam lemah, yang menjadi lemah ketika sebagian dinetralkan. Asam ini tidak dapat 
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berdifusi ke dalam tubulus dentin karena berat molekul tinggi dan ikatan rantai yang 

kuat dan akan mengendap oleh ion kalsium dalam tubulus.  

c. Antikariogenik  

Semen ionomer kaca memiliki sifat kariostatik karena pelepasan fluoride 

jangka panjang, yang memberikan resistensi terhadap karies tidak hanya pada gigi yang 

direstorasi tetapi juga pada gigi sebelahnya. Pengaruh fluorida ditemukan pada zona 

resistensi terhadap demineralisasi, dengan ketebalan restorasi semen ionomer kaca 

sekitar 3mm. Fluorida berkontribusi terhadap penghambatan karies dalam lingkungan 

mulut dengan cara mekanisme fisikokimia dan biologis.  

d. Estetik  

Semen ionomer kaca memiliki derajat translusensi karena kandungan kacanya. 

Translusensi tergantung pada pembentukannya. Penting untuk dicatat bahwa karena 

reaksi hidrasi lambat. Translusensi meningkat seiring dengan usia semen. Resistensi 

terhadap stein sebagian besar tergantung pada permukaan akhir yang baik. Warna 

tampaknya tidak terpengaruh oleh cairan oral dibandingkan dengan komposit yang 

cenderung untuk menyerap warna.  

e. Stabilitas Dimensi  

Pada kelembaban tinggi, semen cenderung menyerap air dan meluas dan pada 

kelembaban rendah, terjadi penyusutan yang rendah.  

f. Ketahanan  

Menurut sebuah penelitian, restorasi semen ionomer kaca dievaluasi pada lesi 

erosi abrasi, 83% menunjukkan ketahanan bahkan setelah 10 tahun . Tingkat kegagalan 

berkisar 0-70%, yang lebih diukur dari keterampilan dokter dari pada kualitas 

perlekatan bahan.  

g. Kekuatan/Strength  

satu keterbatasan utama dari semen ionomer kaca adalah kerentanannya 

terhadap fraktur. Jika dibandingkan dengan komposit dan amalgam, semen ionomer 

kaca lebih lemah dan kurang rigid. Kelemahan tampaknya berada dalam matriks, yang 

bersifat mudah retak.  (Annusavice, 2012) 
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2.6.5  Reaksi setting Glass Ionomer cement 

Autocure-glass ionomer 

Merupakan hasil dari reaksi asam-basa yang merupakan difusi antara partikel glass dan 

matriks. Tiga tahapan dalam pengerasan GIC : 

1. Dissolution  

Terdekomposisinya 20-30% partikel glass dan lepasnya ion-ion dari 

partikel glass (kalsium, stronsium,alumunium) akibat serangan dari rantai 

polyacid (cement sol) 

2. Gelation/hardening 

Ion-ion kalsium/stronsium dan alumunium terikat pada polianion pada 

group polikarboksilat. 

3. Hydration of salts 

Terjadi proses hidrasi yang progresive dari garam matriks. 

Reaksi pengerasan dimulai saat cairan asam polielektrolit berkontak dengan 

permukaan kaca aluminosillicat yang kelak akan menghasilkan pelepasan sejumlah 

ion. SIK mengalami 3 fase reaksi pengerasan yang berbeda dan saling overlapping. 

Fase pertama adalah fase pelepasan ion yang diawali reaksi ionisasi radikal karboksil 

(COOH) yang terdapat dalam rantai asam (asam poliakrilat) menjadi ion COO- (ion 

karboksilat) dan ion H+.  Ion H+ bereaksi pertama kali pada permukaan partikel kaca 

menyebabkan terlepasnya ion-ion seperti Ca2+ dan Na+ ke dalam cairan. Kemudian ion 

H+ tersebut berpenetrasi kembali hingga mencapai struktur yang kurang terorganisasi 

menyebabkan terlepasnya ion Al3+. Saat fase ini, dilepaskan panas dengan suhu 

berkisar antara 3o C sampai 7o C. Semakin besar rasio bubuk dan cairan SIK maka 

panas yang dilepaskan akan semakin besar(Annusavice, 2012). 
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Gambar 2.2    Diagram reaksi awal asam-basa diantara komponen- komponen bubuk kaca 

dan cairan poliasam. Permukaan partikel kaca terlarut oleh asam, sehingga 

melepaskan ion Ca, Al, dan F (Sumber : Albers, 2002) 

2.7 Tebu  

Tanaman tebu tergolong tanaman perdu dengannama latin Saccharum 

officinarum. Sistematika tanaman tebu adalah: 

Divisi  : Spermatophyta 

Subdivisi  : Angiospermae 

Kelas  : Monocotyledone 

Ordo  : Graminales 

Famili  : Graminae 

Genus  : Saccharum 

Species  : Saccarum officinarum 

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


18 

 

 

Gambar 2.3 Tanaman tebu  (Sumber : Chandra,dkk. 2010) 

Batang tanaman tebu berdiri lurus dan beruas-ruas yang dibatasi dengan buku-

buku. Pada setiap buku terdapat mata tunas. Batang tanaman tebu berasal dari mata 

tunasyang berada dibawah tanah yang tumbuh keluardan berkembang membentuk 

rumpun. Diameter batang antara 3-5 cm dengan tinggi batang antara 2-5 meter dan 

tidak bercabang. 

Akar tanaman tebu termasuk akar serabut tidakpanjang yang tumbuh dari cincin 

tunas anakan. Pada fase pertumbuhan batang, terbentuk pula akar dibagian yang lebih 

atas akibat pemberian tanah sebagai tempat tumbuh. 

Daun tebu berbentuk busur panah seperti pita,berseling kanan dan kiri, 

berpelepah seperti daun jagung dan tidak bertangkai. Tulang daun sejajar, di tengah 

berlekuk, dan tepi daun kadang bergelombang serta berbulu keras. 

Bunga tebu berupa malai dengan panjang antara 50- 80 cm. Cabang bunga pada 

tahap pertama berupa karangan bunga dan pada tahap selanjutnya berupa tandan 

dengan dua bulir panjang 3-4 mm. Terdapat pula benangsari, putik dengan dua kepala 

putik dan bakal biji. 

Buah tebu seperti padi, memiliki satu biji dengan besar lembaga 1/3 panjang 

biji. Biji tebu dapat ditanam di kebun percobaan untuk mendapatkan jenis baru hasil 

persilangan yang lebih unggul(Indrawanto, dkk 2010). 
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2.7.1 Ampas tebu (baggase) 

Ampas tebu adalah suatu residu dari proses penggilingan tanaman tebu 

(saccharum oficinarum .) setelah diekstrak atau dikeluarkan niranya pada Industri 

pemurnian gula sehingga diperoleh hasil samping sejumlah besar produk limbah 

berserat yang dikenal sebagai ampas tebu (bagasse). Tiap berproduksi, pabrik gula 

selalu menghasilkan limbah yang terdiri dari limbah padat, cair dan gas. Limbah padat, 

yaitu: ampas tebu (bagasse), abu boiler dan blotong (filter cake). Ampas tebu 

merupakan limbah padat yang berasal dari perasan batang tebu untuk diambil niranya. 

Ampas tebu (baggase)  Sebagian besar digunakan sebagai bahan bakar ketel (boiler) 

yang menghasilkan limbah hasil pembakaran berupa abu ampas tebu (Suhendarwati 

dkk, 2014). Ampas tebu memiliki kandungan sillica (SiO2), aluminat (Al2O3), ferrit 

(Fe2O3) yang sama dengan kandungan bahan biactive glass (Firmansyah D, 2012).  

2.8 Cairan Tubuh Buatan 

2.8.1 Definisi Cairan Tubuh Buatan 

 Stimulated body fluid (SBF) atau Cairan tubuh buatan adalah cairan buatan 

dengan komposisi dan konsentrasi ionik mirip dengan plasma darah manusia. Cairan 

tubuh buatan pertama kali dikembangkan oleh kukubo pada tahun 1990 dengan metode 

yang dikembangkan oleh Kukubo. Cairan tubuh buatan dikembangkan awalnya untuk 

mengevaluasi permukaan perubahan struktural kaca-keramik yang digunakan untuk 

memproduksi tulang buatan, tulang ileum, akar gigi, dan bahan bioaktif yang 

digunakan untuk memperbaiki jaringan keras (Marques, 2011). 
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2.8.2 Komposisi Cairan Tubuh Buatan  

 Berdasarkan Kukubo, dkk. (1990),  komposisi dari cairan tubuh buatan adalah 

sebagaimana pada tabel 2.1.  

Tabel 2.1 Komposisi Ion Pembentuk Cairan Tubuh Buatan 

Ion Cairan tubuh buatan (mM) Plasma Darah (mM) 

Na+ 142.0 142.0 

K+ 5.0 5.0 

Mg2+ 1.5 1.5 

Ca2+ 2.5 2.5 

Cl- 148.8 103.0 

HCO3- 4.2 27.0 

HPO4
2- 1.0 1.0 

SO4
2- 0.5 0.5 

 

Komposisi cairan tubuh buatan memiliki pH ±7,25 pada suhu 36,5oC dengan 

menggunakan 500 ml aquades dan 45 mM HCl. 

2.9 Scanning Electron Microscope (SEM) 

Scanning Electron Microscope (SEM) merupakan mikroskop elektron yang 

menggunakan berkas elektron untuk menggambarkan profil permukaan benda. Prinsip 

kerja SEM adalah menembakkan permukaan benda dengan berkas elektron berenergi 

tinggi. Scanning Electron Microscope menampilkan gambar dalam layar yang dapat 

dilihat secara 3 dimensi. Scanning Electron Microscope mempunyai pembesaran lebih 

hingga jutaan kali dari pada mikroskop optik, selain itu SEM memiliki resolusi yang 

lebih tinggi dari mikroskop optik yang berguna untuk mendeteksi dan analisis struktur, 

bentuk dan ukuran dari suatu sampel yang ingin diteliti (Abdullah dan Khairurrijal, 

2009) 
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Gambar 2.4. Skematik Alat SEM (Sumber : Abdullah dan Khairurrijal, 2009). 

Scanning Electron Microscope terdiri atas beberapa bagian yaitu sumber 

elektron (electron gun) yang berupa filamen kawat wolfram, serangkaian lensa 

(kondensor danobjektif) yang bertindak untuk mengontrol diameter dan fokus 

spesimen,serangkaian apertures, bagian yang mengontrol posisi dan orientasi 

spesimen,daerah interaksi spesimen yang nantinya akan menghasilkan beberapa 

sinyalyang dapat dideteksi dan diproses untuk menghasilkan gambar, serta sistemlayar 

(Hafner, 2007). Cara kerja mikroskop ini adalah sinar lampu dipancarkan pada lensa 

kondensor, sebelum masuk pada lensa kondensor ada pengatur dari pancaran sinar 

elektron yang ditembakkan. Sinar yang melewati lensa kondensor diteruskan lensa 

objektif yang dapat diatur maju mundurnya. Sinar 21 yang melewati lensa objektif 

diteruskan pada spesimen yang diatur miring pada pencekamnya, spesimen ini disinari 

oleh deteksi x-ray yang menghasilkan sebuah gambar yang diteruskan pada layar 

monitor (Respati, 2008). 
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2.10 Kegunaan biactive glass nano sillica  sebagai bahan alternatif di bidang    

kedokteran gigi 

Biactive glass nano sillica mempunyai sifat biokompabilitas, regenerasi 

jaringan, sifat fisik dan mekanis yang baik dan pada ampas tebu mengandung lebih dari 

50 % sillica. Penggunakan biactive glass juga bisa digunakan sebagai remineralizing 

agent. Pada tahun 2014, Mehta et al. menunjukkan bahwa biactive glass (Novamin®) 

dan casein phosphopeptide-amorf kalsium fosfat (CPP-ACP) berhasil 

meremineralisasi karies enamel (Abbasi, 2015). 

Biactive glass juga telah digunakan untuk fusi tulang belakang, rekonstruksi 

krista iliaka, dan untuk mengisi cacat tulang di sejumlah prosedur ortopedi. Awal 

aplikasi klinis ini mengkonfirmasi bahwa bahan ini sebagai implan sangat kompatibel. 

Aplikasi yang lebih baru dari biactive glass adalah sebagai pelapis untuk implan logam 

ortopedi, pelapis trabecular, penggantian tulang, periodontology, endodontology, 

perancah untuk teknik jaringan tulang dan pengobatan regeneratif (abbasi, 2015). 
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2.11 Kerangka Konsep 
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2.12 Hipotesis 

 Perendaman pada cairan tubuh buatan  glass ionomer tipe II dengan penambahan 

bioactive glass nano silica dari abu ampas tebu membentuk hydroxycarbonate apatite 

(HCA). 
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BAB 3. METODE PENELITIAN 

 

3.1 Jenis Penelitian 

Jenis penelitian yang dilakukan merupakan penelitian eksperimental laboratoris 

dengan rancangan penelitian the post test with control group design, yaitu melakukan 

pengamatan atau pengukuran setelah perlakuan lalu hasilnya dibandingkan dengan 

kontrol. 

3.2 Tempat Penelitian 

Laboratorium Biosain  Politeknik Negeri Jember, Jember. 

3.3  Waktu Penelitian 

Penelitian ini dilaksanakan pada bulan September - November 2016. 

3.4 Variabel Penelitian 

3.4.1 Variabel bebas  :  

a. Penambahan 0,04 wt% bahan Bioactive glass nano silica dari abu ampas tebu 

pada bubuk glass ionomer tipe II. 

b. Perendaman Bioactive glass nano silica abu ampas tebu dengan cairan tubuh 

buatan. 

3.4.2 Variabel terikat   :  

Pembentukan struktur hydroxycarbonate apatit bahan glass ionomer tipe II 

dengan tambahan Bioactive glass nano silica abu ampas tebu. 

3.4.3 Variabel terkendali :  

a. Bioactive glass nano silica dari abu ampas tebu. 

b. Metode pembuatan Bioactive glass nano silica dengan metode sol-gel 
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c. Jenis abu ampas tebu. 

d. Jenis pengeringan abu ampas tebu. 

3.5  Definisi Operasional 

a. Abu ampas tebu disebut juga baggase, adalah ampas yang berasal dari tebu 

yang diperoleh dari sisa hasil pengolahan tebu sebagai gula, yang dikeringkan 

dan dipanaskan dengan pembakaran ampas tebu yang dihasilkan oleh pabrik. 

b. Bioactive glass nano silica adalah glass  berbasis nano silica yang dihasilkan 

dari estrak ampas tebu, yang diproduksi dengan metode sol-gel. 

c. Lapisan hydroxycarbonat apatit (HCA) merupakan ion carbonat yang 

bergabung didalam apatit. Prinsipnya ion karbonat mengganti struktur apatit 

di daerah OH dan di daerah PO4
-. Secara umum CO3

2- dominan menganti PO-

2
3. Setelah bereaksi dengan cairan tubuh akan terbentuk struktur mineral 

tulang pada permukaan lapisan yang terlihat pada hasil Scanning Electron 

Microscope (SEM). 

d. Software ImageJ merupakan pengolahan untuk melihat luas area dalam persen 

pembentukan hydroxycarbonat apatit (HCA) dari gambar foto SEM. 

3.6  Sampel Penelitian 

3.6.1 Kriteria Sampel Penelitian 

a. Sampel berasal dari campuran bubuk glass ionomer tipe II yang ditambahkan 

0,04 wt% Bioactive glass nano silica abu ampas tebu. 

b. Sampel dalam bentuk pasta. 

c. Sampel dengan diameter 5mm dan tinggi 3mm. 
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3.6.2 Besar sampel 

Jumlah sampel yang digunakan pada penilaian ini menggunakan rumus (Budiarto, 

2002) : 

𝑛 =
𝑧2. 𝜎2

𝑑2
 

𝑛 =
1,962. 𝜎2

𝜎2
 

𝑛 =
1,962. 𝜎2

𝜎2
 

𝑛 = 1,962 

𝑛 = 3,84 

𝑛 = 4 

Keterangan : 

n = Besar sampel minimum 

𝜎 = Standart deviasi sampel 

d = Kesalahan yang masih dapat di toleransi, diasumsikan d = 𝜎 

z  = Konstanta pada tingkat kesalahan tertentu, jika α = 0,05 maka z = 1,96 

 Jadi sampel yang dibutuhkan untuk mengetahui pembentukan 

hydroxycarbonate apatite adalah sebanyak 4 sampel. 

3.6.3 Kelompok sampel 

- Kelompok Glass ionomer bioactive glass (GIBG 1) Bahan glass ionomer 

yang ditambahkan 0,04 wt% bahan bioacive  glass nano silica dari abu 

ampas tebu yang direndam dengan cairan tubuh buatan selama 5 menit. 

- Kelompok Glass ionomer bioactive glass (GIBG2) Bahan glass ionomer 

yang ditambahkan 0,04 wt% bahan bioacive  glass nano silica dari abu 

ampas tebu yang direndam dengan cairan tubuh buatan selama 30 menit. 
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- Kelompok Glass ionomer bioactive glass (GIBG4) Bahan glass ionomer 

yang ditambahkan 0,04 wt% bahan bioacive  glass nano silica dari abu 

ampas tebu yang direndam dengan cairan tubuh buatan selama 60 menit. 

- Kelompok Glass ionomer (GI2)Bahan glass ionomer yang direndam 

selama 5 menit. 

- Kelompok Glass ionomer (GI3) Bahan glass ionomer yang direndam 

selama 30 menit. 

- Kelompok Glass ionomer (GI4)Bahan glass ionomer yang direndam 

selama 60 menit. 

3.7 Alat dan Bahan 

3.7.1 Alat : 

1. Oven (Memmert,UL 40,Germany) 

2.  muffle furnace 

3. Saringan 200 mesh 

4. Mortar  

5. Pastel  

6. Kertas saring whatman no.42 

7. PH meter elektrik 

8. Timbangan elektrik (4 angka dibelakang koma)  

9. Pengaduk magnet (Wisester) 

10. Beaker 200ml, 250ml, 400ml, 500ml dan 1000ml 

11. Papper pad 

12. Spatula agate 

13. Sendok kecil 

14. Tabung Erlenmeyer 

15. falcon tube 

16. Corong kaca 

17. Cawan Porselin 
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18. Alumunium foil 

19. Cetakan lempeng kuningan 

20. Scanning Electron Microscope (SEM) 

3.7.2 Bahan : 

1. Abu ampas tebu 

2. HCL 0,1 M 

3. NaOH 

4. Na2SO4 

5. Na2O 

6. SBF 

7. CaO 

8. P2O5 

9. HNO3 

10. Si(OC2H5)4  

11. (CaOH)2  

12. Semen ionomer kaca (kontrol) 

13. Simulated body fluid (SBF) 

14. Etanol 96% 

15. Aquades   

16. Glass ionomer (fuji IX) 

3.8 Prosedur Penelitian 

3.8.1 Pembuatan Bioactive Glass Nano Silica 

a. Ampas tebu dikeringkan di bawah sinar matahari, kemudian dibakar dengan api 

selama 2 jam. 

b. Membakar ampas tebu dalam alat furnace bersuhu 9000 C selama 2 hari hingga 

menjadi abu ampas tebu; 
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Gambar 3.1 Pembakaran abu dalam alat furnace bersuhu 9000 C Mengayak  

abu ampas tebu menggunakan ayakan 200 mesh. Hasil ayakan abu 

tersebut ditimbang dan diambil 25 gram (Sumber : Koleksi Pribadi, 

2016) 

 

 

 

Gambar 3. 2 Mengayak abu ampas tebu menggunakan ayakan 200 mesh (Sumber : 

Koleksi Pribadi, 2016) 

 

c. 25 gram abu dimasukkan ke dalam gelas erlenmayer, kemudian ditambahkan  

larutan HCL 150 ml 0.1 M, dan diaduk secara otomatis menggunakan alat 

pengaduk magnet selama 1 jam. Hal ini bertujuan untuk menghilangkan 

kandungan logam lain selain sillica yang terdapat pada abu. Hasil pengadukan 

tersebut kemudian didiamkan pada suhu ruang selama 24 jam; 
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Gambar 3.3 Pencampuran abu ampas tebu dengan HCL menggunakan 

 alat pengaduk magnet (Sumber : Koleksi Pribadi, 2016) 

 

d. kemudian abu ampas tebu disaring menggunakan kertas saring whatman no. 42 dan 

dibilas dengan akuades hingga pH normal (7). Pengecekan pH dilakukan 

menggunakan alat pH meter;  

 

Gambar 3.4 Penyaringan abu ampas tebu menggunakan 

 alat kertas saring whatman no. 42  

 Sumber : (Koleksi Pribadi, 2016) 
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e. mengeringkan abu ampas tebu dalam oven bersuhu 1100 C selama 2 jam, 

kemudian ditimbang; 

     

  a     b 
Gambar 3.5 a. Mengeringkan abu ampas tebu dalam oven bersuhu 1100 C, 

b. penimbangan abu ampas tebu menggunakan alat timbangan digital 

(Sumber : Koleksi Pribadi, 2016) 

 

 

f. abu yang akan digunakan pada tahap selanjutnya adalah 10 gram. Abu tersebut 

dimasukkan ke dalam gelas erlenmayer, kemudian dicampur dengan larutan 60 

ml NaOH 2 N, dan diaduk secara otomatis menggunakan alat pengaduk magnet. 

Suhu alat pengaduk magnet diaktifkan dan diatur sampai larutan mendidih 

selama 60 menit; 

g. Mendinginkan campuran di atas hingga mencapai suhu kamar, kemudian 

disaring dengan kertas saring whatman no 42. Hasil dari penyaringan ini adalah 

filtrat berupa natrium sillicat; 
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Gambar 3.6 Natrium sillicat (Sumber : Koleksi Pribadi, 2016) 

 

h. Mengeringkan natrium sillicat dengan oven bersuhu 1100 selama 2 jam 

(Kristianingrum, dkk.); 

i. Natrium sillicat yang akan digunakan pada tahap selanjutnya adalah 5 gram. 

Natrium sillicat tersebut dimasukkan ke dalam gelas erlenmayer, kemudian 

dicampur dengan 15 ml akuades, dan diaduk secara otomatis menggunakan alat 

pengaduk magnet;  

j. kemudian 2,5 ml etanol 96% ditambahkan pada campuran di atas, dan tetap 

diaduk sampai larutan terlihat jernih; 

k. kemudian HNO3 2 M ditambahkan sampai pH larutan menjadi normal (7). 

Pengecekan pH dilakukan menggukan alat pH meter.  Campuran di atas tetap 

diaduk secara otomatis selama 1 jam; 

l. setelah 1 jam pengadukan, 0,5 gram P2O5 (phosporus pentoxide) ditambahkan 

dan tetap diaduk selama 45 menit; 

m. selanjutnya ditambahkan 4,1 gram Ca(NO3)2 . 4 H2O (calcium nitrate 

tetrahydrat) dan tetap diaduk selama 45 menit; 

n. terakhir campuran tersebut diaduk selama 1 jam sampai terbentuk gel dan  

kemudian didiamkan selama 5 hari dalam temperatur ruang; 
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           a           b                                          c 

Gambar 3.7 a. Natrium sillicat kering, b. Natrium sillicat yang telah dicampur  dengan 

akuades, etanol, HNO3, P2O5, Ca(NO3)2 . 4 H2O dan diaduk menggunakan 

alat pengaduk magnet, c. Mendiamkan campuran selama 5 hari dalam 

temperatur ruang. (Sumber : Koleksi Pribadi, 2016) 

 

o. kemudian gel tersebut dikeringkan dalam oven bersuhu 600 C selama 72 jam. 

Pengeringan akhir dilakukan menggunakan alat furnace dengan suhu 6000 C 

selama 5 jam, dilanjutkan dengan suhu 10000 C selama 2 jam (Adams, dkk.). 

3.8.2 Pembuatan Cairan Tubuh Buatan. 

a. Cairan tubuh buatan ini disusun dengan menggunakan reagen yang terdiri dari 

KCL 0.2 gram/ L, NaCL 0.7 gram/ L, NaHCO3 0.3 gram/ L, Na2HPO4 0.07 

gram/ L, K2PO4.3H2O 0.2 gram/ L, 13 gram/ L, HCL 40 ml, MgCl.6H2O 

0.3gram/ L 

b.  Reagen ditambahkan ke 700 mL air diberikan secara satu per satu setelah 

masing-masing reagen benar-benar tercampur.  

c. pH diatur sehingga menjadi 7,4 dengan cara menambahkan asam klorida  1 

M, dan volume akhir disesuaikan dengan 1 L air (Marques, 2011).  

d. Suhu larutan dipertahankan pada 37°C (Chavan, 2010). 
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3.8.3  Persiapan Bahan Kelompok Perlakuan 

a.  Timbang 2,5 gram glass ionomer tipe II. 

b.  Timbang 10 mg bahan bioactive glass nano silica. 

c.  Lakukan pengadukan secara manual menggunakan tabung kaca dengan 

penutup  hingga tercampur seluruhnya. 

 

3.8.4 Pembuatan Sampel Glass ionomer tipe II dengan campuran 0,04 wt%  

Bioactive glass nano silica dan sampel Glass ionomer  

 

A. Sampel  Glass ionomer tipe II  dengan campuran 0,04 wt% Bioactive glass nano 

silica sesuai trial yang sudah dilakukan sebagai berikut : 

a. Sampel dibuat dengan mencampurkan 1 sendok peres glass ionomer tipe II 

dengan campuran 0,04 wt% bioactive glass nano silica dengan 1 tetes asam 

poliakrilat sesuai aturan pabrik dengan menggunakan spatula agate diatas 

paper pad. 

b. Bubuk dan cairan diaduk sampai homogen membutuhkan waktu sekitar 1 

menit  

c. Masukan adonan kedalam cetakan berupa cetakan kuningan mould dengan 

diameter 5 mm dan tinggi 3 mm menggunakan spatula agate               

d. Kemudian tutup dengan penutup lempeng kuningan.                

e. Memadatkan sampel menggunakan pemberat timbangan ½ kg. 

f. Memeriksa kekerasan sampel menggunakan sonde. 

g. Setelah mengeras sampel dilepas dari cetakan. 

h. Diamkan pada suhu ruang selama 24 jam. 
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B. Sampel kontol menggunakan glass ionomer tipe II. 

a. Sampel dibuat dengan mencampurkan 1 sendok peres Glass ionomer tipe II  

dengan campuran 0,04 wt% Bioactive glass nano silica dengan 1 tetes asam 

poliakrilat sesuai aturan pabrik dengan menggunakan spatula agate diatas 

paper pad. 

b. Bubuk dan cairan diaduk sampai homogen membutuhkan waktu sekitar 1 menit  

c. Masukan adonan glass ionomer tipe II kedalam cetakan berupa cetakan 

kuningan mould dengan diameter 5 mm dan tinggi 3 mm menggunakan 

spatula agate 

d. Kemudian tutup dengan penutup lempeng kuningan.                     

e. Memadatkan sampel menggunakan pemberat timbangan ½ kg. 

f. Memeriksa kekerasan sampel menggunakan sonde. 

g. Setelah mengeras sampel dilepas dari cetakan. 

h. Diamkan pada suhu ruang selama 24 jam. 

 

3.8.5 Analisis Pembentukan Hydroxycarbonate apatit (HCA) 

Sampel yang berukuran 3 x 5 mm dimasukan ke dalam pot obat yang sudah 

diisi cairan tubuh buatan. Kemudian dimasukan dalam inkubator dengan suhu ruang. 

Ditunggu masa perendaman selama 5 menit, 30 menit dan 60 menit. Setelah itu sampel 

diambil untuk dianalisis. Sampel diambil dicuci dengan hati-hati menggunakan 

aquades, Sampel yang kering diamati dengan Scanning Electron Microscope (SEM) 

untuk diamati struktur pembentukan Hydroxycarbonate apatit. 
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3.8.6 Tahapan Uji Scanning Electron Microscope (SEM) 

1. Sampel Glass ionomer tipe II dengan campuran 0,04 wt% Bioactive glass 

nano silica berukuran 3 x 5  

2. Sampel dikarakterisasi menggunakan alat SEM . 

3. Hasil yang tampak pada monitor alat selanjutnya dilakukan interpretasi hasil. 

4. Mengulangi tahapan 1-3 untuk kareterstik glass ionomer. 

3.8.7 Pengolahan Gambar 

a. Pengolahan gambar yang didapat dari uji SEM dengan menggunakan 

software ImageJ 1.49V.  

b. Buka aplikasi software ImageJ,  Klik File pada toolbar, kemudian open dan 

pilih gambar yang akan diolah. 

c. Langkah pertama untuk penggunan ImageJ hal yang harus dilakukan untuk 

menganalisis ukuran area pembentukan hydroxycarbonate apatit (HCA) 

dari gambar sampel  dengan mengkalibrasi ukuran pixel gambar SEM 

dengan ukuran acuan. Ukuran acuan biasanya ditampilkan pada hasil 

gambar SEM berupa garis dengan skala untuk menunjukkan tingkat 

perbesaran yang dilakukan. Kalibrasi dilakukan dengan cara menggambar 

garis lurus sepanjang ukuran acuan dengan memilih icon garis pada toolbar. 

Set skala yang dipilih dengan klik Analyze > Set Scale. Selanjutnya 

pengaturan disesuaikan dengan ukuran acuan dan satuan acuan yang 

digunakan. Pilih kolom global untuk menggunakan skala kalibrasi ini 

hingga aplikasi ImageJ ditutup (Kurniawan et al., 2011). (Gambar 3.1). 
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Gambar 3.7 Pengaturan kalibrasi gambar pada software ImageJ 1.49V (Sumber : 

Koleksi Pribadi, 2016) 

  

 

d. Tahap selanjutnya adalah menyesuaikan tipe gambar dengan memilih menu 

Image > Type > 32-bit. 

e. Untuk menganalisa luas area pembentukan hydroxycarbonate apatit (HCA) 

dapat digunakan menu Image > Adjust > Threshold. Mengatur  level 

Threshlod maka dapat terlihat area pembentukan hydroxycarbonate apatit 

(HCA) akan tertutup dengan warna merah, (Gambar 3.2). 

 

Gambar 3.8 Pengaturan Treshold pada software ImageJ 1.49V (Sumber : 

Koleksi Pribadi, 2016) 
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f. Selanjutnya dilakukan analisa pembentukan hydroxycarbonate apatit 

(HCA) dengan menggunakan menu Analyze > Set Measurement > centang 

Area Fraction. Selanjutnya untuk mengeluarkan hasil perhitungan klik 

Analyze > Measurement dan hasil akan keluar melalui tabel (Kurniawan et 

al., 2011). (Gambar 3.3). 

 

Gambar 3.8 Hasil Pengolahan Gambar dengan Software ImageJ (Sumber : 

Koleksi Pribadi, 2016) 

 

 

g. Hasil yang keluar dari 4 lapang pandang dalam tiap foto dijumlahkan dan 

dihitung sebagai persen area pembentukan hydroxycarbonate apatit (HCA). 

 

3.9 Analisis Data 

Data hasil penelitian dilakukan uji normalitas dengan menggunakan uji 

Shapiro-Wilk  dan uji homogenitas dengan menggunakan uji Levene. Data yang 

didapat terdistribusi normal, maka dilakukan uji parametrik dengan menggunakan 

uji Two Way Anova dan dilanjutkan dengan uji Least Significance Different (LSD) 

untuk menguji perbedaan antar kelompok. 
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3.10 Alur Penelitian 

 

 

Pengukuran area 

pembentukan HCA dengan 

software ImageJ 1.49V 

Sampel Glass 

Ionomer tipe II 

Glass ionomer tipe II dengan campuran 0,04 

wt% Bioactive glass nano silica 

Perendaman Menggunakan SBF 

(5menit, 30 menit dan 60 menit) 

Pembentukan lapisan 

Hydroxycarbonate apatit 

(HCA) 

Uji SEM 

Data 

Analisis Data 

Analisis Data 
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BAB 5. PENUTUP 

 

 

5.1 Kesimpulan 

 Berdasarkan penelitian yang telah dilakukan, disimpulkan penambahan 

0,04 wt% bioactive glass nano silica dari abu ampas tebu pada bubuk glass ionomer 

tipe II dan waktu perendaman yang lama menyebabkan peningkatan pembentukan 

HCA. 

 

5.2 Saran 

5.2.1 Perlu dilakukan penelitian lebih lanjut mengenai sifat fisik  glass ionomer tipe II 

yang dicampur dengan bahan bioactive glass nano silica dari abu ampas tebu. 

5.2.2 Perlu dilakukan penelitian mengenai perbandingan hydroxycarbonate apatit 

(HCA) glass ionomer  tipe II yang dicampur dengan bahan bioactive glass nano silica 

yang telah dipasarkan. 
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LAMPIRAN SURAT A. PENELITIAN 

A.1 Surat Penelitian Laboratorium Biosain Politeknik Negeri Jember 
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A.2 Surat Hasil Identifikasi Jenis Tebu. 
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LAMPIRAN B. ANALISA SPSS 

B.1 Hasil Uji Normalitas 

Tests of Normality 

 

Kelompo

k 

Kolmogorov-Smirnova Shapiro-Wilk 

 
Statistic df Sig. Statistic df Sig. 

Data GIB1 
.272 4 . .892 4 .393 

GIB2 
.230 4 . .907 4 .468 

GIB3 
.199 4 . .987 4 .943 

GI1 
.264 4 . .903 4 .444 

GI2 
.216 4 . .953 4 .736 

GI3 
.265 4 . .900 4 .432 

a. Lilliefors Significance Correction     

 

B.2 Hasil Uji Homogenitas 

Levene's Test of Equality of Error Variancesa 

Dependent Variable:Data 

 

F df1 df2 Sig. 

1.225 5 18 .338 
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B.3 Hasil Uji Two Way Annova 

Tests of Between-Subjects Effects 

Dependent Variable:Data 

    

Source 

Type III Sum of 

Squares df Mean Square F Sig. 

Corrected Model 

127.387a 5 25.477 10.522 .000 

Intercept 
17495.460 1 17495.460 7.225E3 .000 

Bahan 
11.648 1 11.648 4.811 .042 

Waktu 
114.493 2 57.246 23.642 .000 

Bahan * Waktu 
1.245 2 .623 .257 .776 

Error 
43.585 18 2.421 

  

Total 
17666.432 24 

   

Corrected Total 

170.972 23 

   

a. R Squared = ,745 (Adjusted R Squared = ,674)   

B.4 Hasil Uji LSD 
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Multiple Comparisons 

     

(I) 

Kelompok 

(J) 

Kelompok 

Mean Difference (I-

J) Std. Error Sig. 

95% Confidence Interval 

Lower Bound Upper Bound 

GIBG1 GIBG2 -3.77175* 1.100316 .003 -6.08343 -1.46007 

GIBG3 -5.14950* 1.100316 .000 -7.46118 -2.83782 

GI1 1.21475 1.100316 .284 -1.09693 3.52643 

GI2 -1.75300 1.100316 .129 -4.06468 .55868 

GI3 -4.20300* 1.100316 .001 -6.51468 -1.89132 

GIBG2 GIBG1 3.77175* 1.100316 .003 1.46007 6.08343 

GIBG3 -1.37775 1.100316 .227 -3.68943 .93393 

GI1 4.98650* 1.100316 .000 2.67482 7.29818 

GI2 2.01875 1.100316 .083 -.29293 4.33043 

GI3 -.43125 1.100316 .700 -2.74293 1.88043 

GIBG3 GIBG1 5.14950* 1.100316 .000 2.83782 7.46118 

GIBG2 1.37775 1.100316 .227 -.93393 3.68943 

GI1 6.36425* 1.100316 .000 4.05257 8.67593 

GI2 3.39650* 1.100316 .006 1.08482 5.70818 

GI3 .94650 1.100316 .401 -1.36518 3.25818 

GI1 GIBG1 -1.21475 1.100316 .284 -3.52643 1.09693 

GIBG2 -4.98650* 1.100316 .000 -7.29818 -2.67482 

GIBG3 -6.36425* 1.100316 .000 -8.67593 -4.05257 

GI2 -2.96775* 1.100316 .015 -5.27943 -.65607 

GI3 -5.41775* 1.100316 .000 -7.72943 -3.10607 

GI2 GIBG1 1.75300 1.100316 .129 -.55868 4.06468 

GIBG2 -2.01875 1.100316 .083 -4.33043 .29293 

GIBG3 -3.39650* 1.100316 .006 -5.70818 -1.08482 

GI1 2.96775* 1.100316 .015 .65607 5.27943 

GI3 -2.45000* 1.100316 .039 -4.76168 -.13832 
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GI3 GIBG1 4.20300* 1.100316 .001 1.89132 6.51468 

GIBG2 .43125 1.100316 .700 -1.88043 2.74293 

GIBG3 -.94650 1.100316 .401 -3.25818 1.36518 

GI1 5.41775* 1.100316 .000 3.10607 7.72943 

GI2 2.45000* 1.100316 .039 .13832 4.76168 
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C.1 Alat Penelitian 

        

1. Pemberat timbangan 

2. Cetakan Lempengan ukuran tinggi 3 mm diameter 5 mm 

 

1. Tabung Erlenmayer    4. Petridisk  

2. Beaker glass     5. Glass Ukur 

3. Corong       6. Labu ukur 

2 1 

2 

6 

3 

4 

1 
5 
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1. Mortar     4. Sendok Kecil 

2. Pastel     5. Pipet 

3. Cawan     6. Mikro Pipet 

 

 

 

1. Pinset    3. Gunting 

2. Spatula Agate   4. Sonde Lurus 

1 

6 

2 

5 

4 

3 

4 2 
3 

1 
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   (Timbangan Digital)     (Desikator) 

 

 

 

          

(Furnice)      (Inkubator) 
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Scanning Electron Microscop (SEM) 

        
 (Ayakan 200 mesh)         (Pengaduk magnet)                 
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              (pH meter)                           (Oven) 
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C.2 Bahan Penelitian  

 

1. Akuades      5. HCL (hydrochloric acid)  

2. NaOH (natrium oxide) 2 N   6. HNO3 (nitric acid)  

3. P2O5 (phosporus pentoxide)   7.  Etanol 96% 

4. Ca (NO3)2 . 4 H2O (calcium nitrate tetrahydrate) 

  

1 

2 

3

 
 a 

4 5 6 7 
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1. Bioactive glass nano silica 0,04 wt% dalam semen ionomer kaca 

2. Semen ionomer kaca  

3. Asam poliakrilat 

4. Paper pad 

5. Sendok takar pabrik 

 
1. Kertas saring whatmann no 42 

2. Alumunium foil 

3. Tisu 

1 2 
3 

4 
5 

1 2 3 
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LAMPIRAN D. HASIL ANALISA SCANNING ELECTRON MICROSCOPY 

(SEM) DAN ANALISA SOFTWARE IMAGEJ. 

D.1 KELOMPOK GLASS IONOMER DENGAN PENAMBAHAN 

BIACTIVEGLASS NANO SILICA YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 5 MENIT 
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D. 2 KELOMPOK GLASS IONOMER DENGAN PENAMBAHAN 

BIACTIVEGLASS NANO SILICA YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 30 MENIT 
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D. 3 KELOMPOK GLASS IONOMER DENGAN PENAMBAHAN 

BIACTIVEGLASS NANO SILICA YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 60 MENIT 
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D. 4 KELOMPOK GLASS IONOMER YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 5  MENIT 
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D. 5 KELOMPOK GLASS IONOMER YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 30 MENIT 

 

   

   

  

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


73 
 

 

D. 6 KELOMPOK GLASS IONOMER YANG DIRENDAM PADA CAIRAIN 

TUBUH BUATAN SELAMA 60 MENIT 
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LAMPIRAN E. JUMLAH LUAS AREA SAMPEL 

No Kelompok Jumlah Pembentukan HCA 

1 GIBG 1 23.540 

2  25.231 

3  26.745 

4  23.374 

5 GIBG 2 27.355 

6  26.897 

7  28.674 

8  31.051 

9 GIBG 3 28.296 

10  30.044 

11  31.523 

12  29.625 

13 GI 4 24.423 

14  23.727 

15  22.993 

16  22.888 

17 GI 5 28.816 

18  25.302 

19  24.286 

20  27.498 

21 GI 6 27.097 

22  29.953 

23  28.504 

24  30.148 
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